












































































































































































































































































































































































































































































































































































































































































































































































































































































23 • Other Things You Might Need to Know 

Or: 

• Hold down the Option key and press on the application's icon in the 
Dock (don't click-hold the button down). The menu that pops up 
typically says "Quit," but with the Option key down it changes to "Force 
Quit." Choose that item and it will force quit the selected application. 

i El To Tipperary t1 

I .Finder 

The Dock menufm· TextEdit (the selected application) shows "Quit." 

With the Option key down (either before or after you choose 
this menu), "Quit" changes to "Force Quit." 

Relaunch the Finder 
If you have trouble in the Finder (at the Desktop) , you can't quit the Finder. 
But you can relaunch it which might clear up weird little problems you may 
be having. Relaunching the Finder does not affect your other applications or 
open windows. 

To relaunch the Finder: 
1. From the Apple menu, choose "Force Quit. .. ," 

or press Command Option Escape. 

2. In the dialog box, click once on "Finder." 

3. Click the Relaunch button. 

0 C' 0 For« Quit Appnutlons 

If an application doesn't respond for a while, 
select ih; nam·e and click Force Quit. 

lftl Grab 

System Preferences 

TextEdit 

You <at' b'( press I 
· Commancft 0ption+-£!;eape. 
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r.·i~.~:.~ 
'111 

'•-.::;:,....·" 

Netlnfo Manager 
This is the Netlnfo 

Manager icon in the 
Utilities folder. 

404 

Log in as the root user 
There is another user on the Mac, called the root user, or superuser. By logging 
into this account, you can change any file on the entire Mac, even system files that 
you as the Administrator are not allowed to touch. By default, the root account is 
disabled in Mac os X because it is phenomenally easy to destroy your entire system 
with the click of a mouse. But sometimes you try to throw away items you created 
or you might try to install software into the Applications folder and the Mac yells 
at you that it's not possible, usually because you don't have sufficient privileges. 
And you wonder, "Well, I'm the only person who has ever used this machine-if 
I don't have privileges, who on earth does!? " This is when you might have to log 
in as the root user. It's not something you want or need to do often, and you don't 
want to leave your computer sitting around with the root user available because as 
the root user, you (or anyone using your machine) has access to read, write, and 
destroy any file on the Mac, including all other user files. 

But if you need to do it, log in as the root user, do what you need to do, then log out 
and disable the root user when you're done. You must know the Administrator's 
short name and password to do this. 

To enable the root user and log in: 
1. Click on the Applications icon in any Finder window, or go to the 

Go menu and choose "Applications." 

2. In the Applications window, open the Utilities folder. 

3. In the Utilities window, find and double-click "Netlnfo Manager." 

4. In the Netlnfo Manager window, click the padlock icon in the 
bottom-left corner. 

s. In the dialog box that 
appears, type in the 
short name of the main 
Admin of the Mac, plus 
that Admin's password. 
It must be the name 
of the main, original 
Administrator-not 
a user who has been 
granted administrative 
status. Click OK. 

local ElllocalhosLcybermesa.com - 1 

Directory Browser ,, . "' afpuser_allases ~In 
alians •· e' 
conflg ,. .• 

,.[.; _groups 

Directory: 1 

lotallnat/loca! 

®de the lode to m.tke changts. 

r?-1 ..._; 
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6. From the Domain menu, slide down to "Security," and 
then choose "Enable Root User," as shown to the right. 

Open... ICC 
Open By Tag... OICO 

(If the root user has already been enabled, this item says 
"Disable Root User"; skip to Step 9.) 

Open Pa,ent 0 P 

Close 
Savo ~~ 

Revert to S-w~d XU 

1. If there is not a root password already, you will be asked to VIew 

create one. Use the standard password guidelines: difficult Servers ..• 

Manage Domains 
Save Backup ... 

.. to figure out, a combination of letters and numbers, no 
non-alphanumeric characters, no spaces, etc. Capital 
letters and lowercase letters are different characters in a 
password. Write this password down somewhere!! 

Restore From Backup ... 

Page Setup ... 
Print... 

After you type the password the first time, you'll be asked to type it again 
to verify it. Click the Verify button. 

s. You have now enabled the root user. The padlock in the Netlnfo 
window will automatically shut-you'll get a message that you must 
"re-authenticate" to make any more changes. Quit Netlnfo. 

9. Next you need to log out so you can log in as the root user. But before 
you log out, go to the Login preferences pane (in the System Preferences) 
Click the "Login Window" tab. 

10. Check the "Display Login Window as" rad 
password entry fields." Or, if you want to 
that displays the photos the users have c 
"Show 'Other User' in list for network 
users." Either choice will give you an 

io button to display "Name and 
keep the list of user accounts 

hosen, then check the box to 

edit box where you can log in as the 

·ee o ~ ~ R 6 • >'-All Di~plays Soutld Ntrwark St&ttup Oiilt 

ICP 

Oeauthentlcate 
Chang~ Root Password .. 
Enlblc RQot User 

This option is 
active when you 

choose the 
"List of users" 
radio button. 

c 

root user. / Login lio(s r logln Wlii'ciOWl '} 

11. From the Apple menu, choose "Log 
Out. ... " In the Login window that 
appears, type "root" as the user 
name, and type the root password 
you assigned earlier. Voila. You can 
now delete files that you weren't 
allowed to delete earlier. Be careful. 

12. When you' re finished doing your 
root business, log out, log back in as 
yourself, and disable root access in 
the Netlnfo Manager (Steps 1-6). 

I!! Automatically log In 

N~: robln I ~- CEJ 
.. ( Display Login Window as: 0 Name ond possword entry fteld s •11 

() list of users wlrh accounts on this computer l o'"~~-, .. ~ '"''"'"-"'""" 
~Show password hint after 3 a"empts to enter a password 

A htnt un tH: crtoned ln lht Ustu P~nt. 

1 (!} Clld: I he lodt to prevent further changu. 

-

I' ,, 

I' 
it 

i' 
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Tip: If Mac OS X yells 
at you because a file 

is Locked, but the 
"Locked" button is 

not checked in 
Show Info, it may 
have been checked 

in OS 9 in Get Info. 
Restart your Mac in 

OS 9, unlock the file, 
then go back to OS X. 
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Locking a file 
You can see information about every file icon in a Show Info window (details 
about Show Info are on page 392). One of the things you can do in a Show Info 
window is lock a file so no one can make changes to it. 

To get a Show Info window: In the Finder, click once on an icon, 
then press Command I, or go the the File menu and choose "Show Info." 

There is a "Locked" checkbox in the lower-left comer of the Show Info window. If 
you check this box (click once on it), this file cannot be renamed or inadvertently 
thrown away- as soon as it hits the Trash, a dialog box comes up telling you a 
locked file cannot be thrown away. It also becomes a read-only file: anyone can 
open and read the file, but no one can save any changes to it. You can't even change 
the Show Info comments. This is handy for sending around copies of a document 
and ensuring no one accidentally changes anything. 

To lock the file, click in the checkbox. 

To unlock the file, click in the checkbox again. If there is no V', 
the file is unlocked. 

0 0 ·~olldaY Letter 

~~~ Holiday Letter 

Show: cc;nHal !~formation -[il 
Klnd: Document 
Size: 1.1MB on disk (1,199,984 bvlesl 

Wher1: Mile OS X/UsersjroblntDocume.ntsj 
C>uttd: Wtd, /l,flr 2S, 2001, li:ZS PM 

Mod;fttd: Sun, Aug 12. 2001, 11:26 PM 

elL 
o ee 

If you look very closely at 
a locked file, you 'II see a 
tiny padlock in the lower­
left corner. 

Trash 

Prep~ring move to "Tnsh" 

The opor.otlon c~nnot M completed M<•use you 
do not h•v• suffident privileges for some or the 
items. 

This message can mean a file is locked 

As you can see, this isn't a very secure way to safeguard a file-all anyone has to 
do is Show Info and unlock it. It's just a way to prevent things from happening to 
the file accidentally. 

You'll find there are a number of files you cannot lock, including all of your Home 
folders. Apple is trying to protect you from yourself. 
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Moving icons 
To move icons, simply press-and-drag them. You can put any icon into or drag 
any icon out of any folder icon. 

• When you drag an icon (or any file, no matter what it looks like) from 
one place to another on the same disk, the computer moves it to the 
other place. 

• When you drag a file from one disk to another disk, the computer 
copies it to the other disk. For details about copying, see Chapter 12. 

Creating your own icons 
Ryan's Writings You can create your own icons and apply them to any existing icons, and you 

can copy icons from one file and apply them to another. 

• Open an OS X graphic program like AppleWorks (paint or draw). 
Or use any clip art or photo image instead. 

I changed the 
standard folder icon, 
above, to a photo of 
Ryan, below. 

• In the graphic program, create the little picture that you want as your 
icon. No matter what size you make the art, the Mac will reduce it to an 
appropriate size as it becomes the new icon. But if you make it too large, 
it will be unrecognizable when reduced. 

• Select the image you created or found; copy it (from the Edit menu). 

• Go back to a Finder window. 

I 
Ryan's Writings 

This is actually 
a folder. 

• Click once on the icon whose picture you 
want to replace. From the File menu, choose 
"Show Info'' (or press Command 1). 

Click here to 
select the icon ~ 

image, either 
to paste in a 

new one or to 
clear out an 
exiSting one. 

Kind; Folder 

• Click once on the icon that appears in the 
upper-left of the Show Info window 
(to the right, circled). 

• From the Edit menu, choose "Paste" 
(or press Command V). 

• Close the Show Info window 
(press Command W). 

Size; Glkul&tlrt~~ Size 
Where: MK OS X/Usvs/rab!n/Plauns/ 

Crtartcl: Tut, Stp 4, 2002, 9:14PM 
Modified: Tile, Stp 4, 2002. 9:14 PM 

C:Locktd 
Comm111U: 

To change an icon back to the original, select its tiny icon in the Show Info 
window; from the Edit menu, choose "Cut." The original icon will reappear. 
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The 11Classic" environment 
Mac OS X is a fabulous operating system. But at the moment, there are many 
applications that can't run in os X because every application has to be rewritten 
for the new system. So, when necessary, applications that can't run in Mac OS x 
will automatically open in Mac OS 9. These applications are considered "Classic 
applications." 

Opening Classic 
If you double-click on a Classic application, it will open OS 9 for you, but I've found 
there are fewer problems if I open Classic first, and then open the application. 

To open the Classic environment: 

System Pt·eferences 
icon. 

1. Open System Preferences: either click on the icon in the Dock, 
or go to the Apple menu and choose "Preferences .... " 

2. In System Preferences, click on the Classic icon, or choose "Classic" from 
the View menu. 

408 

I c!:, I 3. In the Classic preferences pane, click the "Start" button. It takes a minute 
or two for Classic to get up and running. 

Classic icon. 

Jj you want Classic to 
stm·t up everytime you 

turn on your iMac, 
check this box. 

eo 
~ 

Shew All 

Classic is an e nvironment for running Mac OS 9 applications. It starts 
automatically when a Classic application is launched, or It can be started here. 

Classic is not running 

Select a startup volume for Classic: 

Work Project5 ~ 0 Start up Classic on login to this computer 

Applications UJ 
Mac 0$ 9 J!... 
Mac OS X 

CHck Start to start the. Classic environment. 
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4. While Classic is starting, you'll see the small window shown below, with 
the status bar telling you how much more time it will take, relatively. 

If you want to see the whole "Desktop" and the extra files that are 
loading into Mac OS 9, click the triangle in the bottom-left corner of 
this small window. 

Classic Environment starting from "Mac OS x· 

s. You'll see the OS 9 Desktop as it loads, as shown on page 24. 

Some applications are what's called "Carbon," which means they can open in both 
Mac OS 9 and OS X. Sometimes an application is capable of opening in OS X, but 
some of its features depend on "extensions" installed in Mac os 9. In this case, 
you need to open the application in Classic (Mac OS 9) to get full functionality. To 
force an application to open in Classic, use the Info window: single-click on 
the application icon to select it, then press Command I to open the Info window, 
shown below. 

DropStuff Info 

IOnd: Application 
Size: 868 K8 on disk (886,596 bytes) 

Where: Mac OS X:Appllc•tlons:StufRt Ute 
6.5: 

Created: Fri, Sop 14. 2001. 12:00 AM 
Modified: Frl, Sop 14, 2001, 12:00 AM 
Version: 6.5, Copyright c 1990·2001 

Aladdin Systems, Inc. 
Pan ofSwffit Ute 6.5 

Check this box to force the Carbon 
application to open in Classic. 

If you have Mac OS X on your machine but you start up your Mac with OS 9 most of 
the time, you'll need to know lots more about OS 9 than we can tell you in this book. 
If so, please read The Little Mac Book, seventh edition, from Peachpit Press. 
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~ 
Apple System Profiler 

410 

Apple System Profder 
The Apple System Profder (in your Utilities folder) is the place to go to find out 
your Mac's serial number, all the details about your hardware and software, memory 
chips, every application on your hard disk, and more. You won't need to use it very 
often, but it's good to check it out so you know what information is available here. 
If you ever have to call tech support, they will probably ask you to open this. 

Mac OS overview 

Startup devtce 

y Memory overview 

II> Bulh- ln m•mory: 7&8 M8 
VIdeo memory. 32 MB 
L2 tache: 256K 

T Hardware overview 

Machin" 10: 406 
Modef name: 

System. 

N>rnt: 

K•yboard type: Apple Pro Keyboard 

'Y Network overview 
EtMrne1 Where: bUill-In 

Address. 00.03.93.78.d9.ac 
Bro;adast addttu. Not ;vailable 

Eth.t:rnt:l When_: Wireless 

Addreu : 00.30.65.1d.de.bl 
Broldt"'t •ddren. 192.168.251.2S5 

Y Production information 
ROM revtsion: 
Boot ROM vonlon: 4.3412 
S.ri•l number; QT235R-LF4- ff12-4<2 
Software bundle: Not applicable 
Sales order numbu : Not apphcablt 

Mac OS X 10. 1.4 (SQ12Sl 

~tadmosh HD 

PC100- 222S 

I Ptoceuor Info: Powt rPC C-4 

Machine 800 MHz 

Ffag_s~ Muhi~ast, Simplew, Runnlno, b6. 
Broadust. Up 

IP Addre": Not available 
net mask. Net a'lt~IJ~ble 

Flogs: Multlast, Slmpltx, Running, b6. 
Brcwlast. Up 

IPAddten: 192.168.254.16 
net mask: 255.255.255.0 

This "System Profile" pane shows me which version of the software this 
computer is running, how much memory it has, what kind of keyboard 
I have, my serial number, and more stuff that I don 't even know what it is. 



Sh.{.rloc~= 
.finJ it on Your iMac 
oront~ W~L 

If you click the Sherlock Holmes hat you see in the Dock, you'll get the application ~ 
shown below, called Sherlock. Sherlock is the tool you use to find any file on your 
hard disk, or to find things on the Internet like old friends, shopping bargains, 
definitions of strange words, research articles, entertainment, and more. 

Second, type 
in the name of a 

file to find 
its location on 

your hm·d disk. 

€) File Names 0 Contents O ' Custom 

1-~,....L-.,--=Na~- Index St;rtus 
~ robin Indexed Sun, Se.p 2. 2002, 3:33 PM 

@ tit Robin's Hard Disk Can' t index this volume. Add folders and lndu them. 

Click any of the other "channels" to log on to the Internet 
(providing your connection is set up first) and find 
various sorts of information. 

Third, click this 
button to have 
Sherlock search 
your hat·d disk for 
the desired file. 

Note: If America 
Online is your only 
emaiVIntemet service, 
you must first open 
and log on to AOL 
before you can use 
Sherlock to search 
the Internet! 
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Channels 

W1Jen you position 
the pointer over a 

channel, a Help tag 
appears that tells 

you what that 
channel is for. 

The buttons across the top of Sherlock represent what Apple calls channels, or 
customizable sources of information. Position your mouse over any of the buttons 
and pause a few seconds-a hint, called a "help tag," appears that tells you what 
that channel can help you find, as shown to the left. Try it. 

Across the row in the example below, the channels are Files, Internet, People, Apple, 
Shopping, News, References, Entertainment, and a channel called My Channel that 
you can customize. Plus there are empty slots where you can add other customized 
channels and your own icons. 

Click on a channel to select it; the 
contents in tbe middle panel will 
cbange with eacb channel. Try it. 

This channel is selected (notice 
the slightly darker sbade). 

Index Status 

This is the Search button. 
After you have typed in a 

request, click this button to 
have Sherlock find it. 

0 ( Custom 
In this edit box, type in 

what you want to find 
(details on opposite page). 

Indexed Thu. Sop 13. 2001, 1:49 PM 

Depending on the channel you 
choose, you'll have differertt 

options in this middle panel. Find Items whose file ~me c.ontainJ •papyrus" 

Click different channels, above, 
to see how the list in this panel 

changes. Sherlock will searcb only 
the items that are checked. 
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After a search, the results will 
appear in this middle panel. The information in 

this lower panel is 
different fo1· 

different channels. 
The details of 

selected results 
will appear here. 

Drag on this little 
icon or the simt"lar 
one toward the top to 
resize the p anels. 

Drag on this corner to 
resize the entire 
Sherlock window. 
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Find a file on your hard disk 
Aflle is anything on your hard disk. Documents, folders, applications, fonts­
everything is considered a file. Every file on your Mac is represented by an icon 
and has a name. Sherlock can find files by their names. 

To search for a ftle on your hard disk: 
1. From the Dock, click the Sherlock icon (shown to the right). 

Or go to the Desktop and press Command F. 

2. Click the first channel button, the one with the picture of a computer 
(circled, below; it's probably already selected). 

3. In the middle panel of the window you'll see the name of your hard disk 
and Home, as shown below. Depending on how your computer is set up, 
you might see other items in that panel, such as any "partitions" you 
might have, or any disks that are mounted (cos, Zips, etc.). Make sure 
there is a checkbox in any disk you want to search. 

4. In the edit box (see below), type a word that is in some of the file names 
on your computer. For instance, type "letter" or "setup." 

s. Make sure the round radio button for "File Names" is checked 
(shown below). 

6. You'll notice in the lower panel that Sherlock reiterates what you are 
looking for. 

7. Click the Search button (the round, green one with the magnifying glass) . 
Then turn this page and continue. 

This is the Sherlock 
icon in the Dock. 

Tips: It doesn't 
matter whether 
you type capital or 
lowercase letters­
Sherlock will find 

"Love Letter" even 
if you search for 

"love letter." 

Spaces, however, do 
matter. That is, "love 
Letter" will not find 

"loveletter. " 
If you don't know the 
exact name of the file, 
just type any part of 
it that you think is in 
the file name, such 
as "love." 

Choose the Files channel to search for files on your hard disk. 

Type your request 
in this edit box. 

Make sure this 
button is selected 

so Sberlock will 
search for your 

request in a file's 
name (as opposed 

to its contents). 

e 

O~m 

m robin tndextd Thu, Sep 13, 2001. 1:49PM 

~ 9 Robin's Hard Disk Can't Index thli volume.. Add folden and lndu them. 

Click this button 
to searcb. 

Rigbt now this panel 
reminds you of wbat 
you m·e looking for. 
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Opening a found file 
Sherlock will take several seconds to search your entire hard disk. The results will 
look something like those shown below. In the middle panel of the window is 
a list of all the files that have your request in the file name; click once on any 
one of those files, and in the lower panel, Sherlock will tell you where that file 
is stored. 

Click once on the fi le 
you were looking 

for, and in the lower 
panel you 'I/ see 

exactly where that 
file is stored 

Quick search tip: 
If you're looking for a file 
you created or worked on 

today or yesterday, tl}' the 
"Custom ... " menu. 

<9 1 ~Custom 
Applications 
larger than 1MB 
Modified today 
Mod1f1ed y~sterday 

Edit... 
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W1.Jen necessary, click this Back button to return to the list 
of volumes you just left. There is no "Forwm·d" button to 
return to this window- you'll just have to click the Search 
button again. 

Q contents 

Rlcn Text Format (Rffi document 

ltt.ms Found: 2 

tJ, Robin'~ Hilrd Disk 

[J.or Users 

(!! robin 

L) Oo<uments 

rJ Ryan's Essays 

~ Ptlpyrus Tales 

This example shows that the 
selected file "Papyrus Tales" 
is in a folder called "Ryan :s­
Essays, " which ts in the 
folder "Documents, " which 
is in the home of "robin, " 
which is stored in the "Users" 
foldet; which is on the bard 
disk named "Robin :s-

Hard Disk." 

Size !hte Modified 

ll6KB 8!20!02. 3:53AM 

4KB 9/ S/02. 4:36 PM 

Click on any of these 
column headings to 
organize the content 

by that heading. 
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Once you have located the file you want, there are several things you can do. First, 
click once on the file name in either the middle or the lower panel of Sherlock to 
select that file. Then do one of the following: 

• To open the file, double-click the file name, or single-click the 
file name to select it and press Command 0. This will, of course, 
also open the application that the file was created in. 

New Window 
Open Item 

XN 
XO . . 

Open In New Browser Wtildow XB 

• To open the folder in which the file is stored, press Command E. Print Item XP 
Move to Trash X<BI 

• To print the item (if it's a document), press Command P. 
Close Window XW 

Show Original XR 

xs • To move the item, drag it to wherever you want, outside 
of Sherlock. 

Save Search Cllterla ••. 
Open Search Criteria ... 

• To copy the item, hold down the Option key and drag the file somewhere 
outside of Sherlock. 

• To delete the item, drag the file from the window to the trash basket, 
or select the file and press Command Delete. 

• To find the original of an alias, select its icon and press Command R. 

For the following technique, you must select the file in the middle panel­
it won't work if you select the file in the lower panel. 

.,. To make an alias of the file, hold down the Command and Option keys 
and drag the file to the Desktop or into a folder; let go and 
an alias will appear (see Chapter 23 for information about aliases). 

Do a new search without losing the previous search 
After you've done one search, you can start another without eliminating the 
search criteria or the results from the first search. Just go to the File menu in 
Sherlock and choose "New Window," or press Command N. You can have any 
number of search windows open at the same time. 

How to quit Sherlock 
When you want to put the Sherlock window away, click in the little red button in 
the upper-left corner of the window. 

When you want to put the Sherlock application away (that is, you want to quit) , press 
Command Q or choose "Quit Sherlock" from the Sherlock menu. 

Tip: Click on a file 
name to select it, then 
go to the File menu to 
see what your options 
are for that particular 
type of file. 

415 



24 • Sherlock: Find it on Your iMac or on the Web 

Search a spedftc folder 
Sometimes you want to search one particular folder or several folders instead 
of every mounted disk. That's easy to do. (Sherlock calls all folders or disks 
"volumes.") 

To search a particular folder: 
1. First: 

• Either find the icon for that folder on your Desktop or in a Finder 
window. Drag the folder icon and drop it in the middle panel of the 
Sherlock window. 

• Or from the Find menu in the menu bar across the top of the 
screen, choose "Add Folder .... " Then use the dialog box to navigate 
to the folder of your choice. Select the folder and click "Add." 

2. Back at the Sherlock window, make sure there is a check in the box 
next to each folder you want to search. 

3. Continue with the search as you did on the previous pages. 

· .. f_Q~---- Sherfod< ~~--·--
~i~' 8 !: .6l' rfJl ''11lm' 1 -i!~Aj:~ 1 ;--; 
1.~1:~ 'A!i•!i~l'wl!au!!V!l~l' I 

:;: iOear John ® 
@I File Names 0 Contents e (CiHtOnl------]!) 

on t·~·--~··ram.r-·,;,.=='~'-'"'1'•-t Index Status _______ .,- M- -[.i Documents Indexed Thu, Sep 13, 2002, 1:49PM --

This shows that of the 
various "volumes" available, 
Sherlock will search only the 

l!f iJ Penon~ Stuff Indexed Thu, Sep U, 2002. 1:49PM 

(J ~ robin Indexed Thu, Sep 13, 2002. 1:49PM 

[! :2\ Robin's Hard Disk Ciln't index this wlume. Add folders .and index them. 
Drag the icons 
of the folders 
you want to 
search and 
drop them in 
this space . 

folders called "Documents" - Find llems wllose frle not.,;,;~~=o;;J~--;;:----­
and "Personal Stuff." 
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. f.fr' 

To remove a folder from Sherlock: 
1. Select the folder you want to remove. You must select the name of the 

folder. That is, clicking in the checkbox does not select the folder to 
remove it. 

2. From the Find menu, choose "Remove Folder." 
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The Contents button and indexing 
Sherlock will search through the contents of most text files. For instance, maybe 
you're working on a research project and you've created dozens of files on the topic 
of chess. You want to find all the papers in your collection that mention "en pas­
sant." That's when you click the "Contents" button; instead of searching for just 
the name of a file, Sherlock will actually read the contents of files. For instance, 
you might have written an article that you named "Special Moves in Chess," and 
in the article itself you wrote about the en passant move, but you also mention en 
passant in three other articles with different names-Sherlock will find every file 
that includes the phrase "en passant" in the text. 

BUT Sherlock cannot search the contents of your files until it has first indexed 
every file. That is, Sherlock has to read every file on your computer and then 
organize every word into a database that it can search when you request it. 
Logically, if you write more articles after Sherlock has indexed the files on your 
hard disk, Sherlock has to index things again to update and add those new files 
to its database. 

On Name 

~ (tS Documents Indexed Wed, Sep 12,2001. 10:43 PM 

~ [l Personal Stull 

~ (!! robin 

~ @ Robin's Hard Disk 

Sherlock cannot 
search the text in 
every file. It can 
search files saved 
in Rich Text Fomzat, 
Plain Text, most 
PDF documents, 
and some 
wm·d processing 
documents. If you 
have lots of files 
you want to search 
and Sherlock 
can't do it, buy 
Adobe Act'Obat 
and learn to use 
it. It's amazing. 

Users (like you and me) are not allowed to change the "first 
level" of the computer; the fi ,·st level is the hard disk or parti­
tion that holds tbe operating system. Because a user can't 
change it, that level cannot be indexed. As the note says, 
you can add individual folders from that disk into Sherlock 
(as explained on page :368) and index the individual folders. 
(This message does not mean to add folders to that disk.) 
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To search the Internet, 
Sherlock has to go to 

the Internet, which 
means you must 

have your Internet 
connection already set 
up and working before 

you use this feature 
of Sherlock. 

Internet [I] 
~.p~ [i] 
App~ [iJ 

Shopping [iJ 
~m[i] 

Refu~nce l __ '] 
Entertainment ~ 

--··--Tr- ----• 

When you choose 
any of the Internet 
channels and go to 
the web, you 'II get 
advertisements in 

the very bottom 
portion of Sherlock. 
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Find something on the Internet 
Besides searching your disk, Sherlock will also search the Internet and the web. 
Each of the buttons across the top of Sherlock is called a "channel." Each channel 
is set up to search specific areas of the web (except the very first channel, which 
finds files on your computer). When you click on a channel to select it, you'll see 
the middle panel of Sherlock change to fit the channel's specifications. Try it. 

To search the Internet: 
1. Open Sherlock (click the Sherlock Holmes hat in the Dock or press 

Command F when you are at the Desktop). 

2. Click once on the "Internet" channel (the globe). 

If you are looking for a person, click the "People" channel button instead 
of the "Internet" channel. If you're looking for news, reference material, 
or Apple support information, click the appropriate channel. If you want 
to go shopping, take a look at pages 420-421. 

3. Type in the item you wish to look for. If it is a phrase, put quotation 
marks around the phrase; for instance, if you are looking for a recipe for 
chocolate pecan pie, type "chocolate pecan pie" in quotes. 

If you don't use the quotes, Sherlock will find every web page with the 
word "chocolate" on it, plus every page with the word "pecan" on it, 
plus every page with the word "pie" on it. But with the phrase enclosed 
with quotes, you should only get pages that contain the entire phrase 
"chocolate pecan pie." 

4. Click the Search button (the big one with the magnifying glass). 

If you have a full-time connection, Sherlock will jump on it and do 
the search. 

If you have a dial-up account, Sherlock will log on to the Internet 
through your ISP (Internet Service Provider). 

If you use AOL you must first open and log on to AOL before you click the 
Search button. 

s. You will get a list of "results," as shown on the opposite page. Click once 
on a result, and details of that web page will be displayed in the lower 
panel (also shown). 

6. To go to that web page, either double-click the title in the middle panel 
of Sherlock, or single-click the underlined link in the lower details panel. 
Read the captions on the opposite page. 
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2. Click the channel that you want to search. 

3. Type in 
what you're 
looking for. 

s. Click once on 
a result to see 
details below, 

or double-click 
to go dit·ectly to 
that web page. 

6. To go to 
this web page, 

single-click 
this link. 

-. Recipes - 8ourbon and Chocolate Pecan Pie --

<q Chocolate Peun Pie IV --

Eij Chocolate Pecon Pi< --

~ Recipes lor Chocolates by ••• - RICH CHCICOLATI P£CAN P -­

ll TheNutritJonGuvs.com - ... upplements just for Women -­

l]lelte"s Cullrwia: Food Art ••• •. Retlpes and Cooking Tip• --

ll The j.11mu Beilfd House R«lpe COllect ion --

a: CliocOlatePocan Pie -
11 Christmaslsoon) -
~ Chocolate Pecan Pie 

southernfood.U>out .com 

www.pltrecJpe.com 
www.geoduu.com 

WWW'.nutrltionguys.com 
www.lelttsculinaria.com 

www.1titesculinari.t.com 

www.1ti!eJculin.Jrt.t.com 

joyusplactO.tripod.com 
WVN~.bt:aniln .. btstro.com 

4. Click tbe 
Search button. 

Using tbe 
scroller or 
m·rows, scroll 
tbrougb this list 
of results. 

Jj you see a link that says 
"Find similar pages" or 
"Related pages," click it 

to gel a list of more 
t·esults that match tbe 

selected web page. 

To resize the 
results and the 
details areas, dt·ag 
tbis little symbol. 

To resize the entire 
window so you can see 
the names of pages and 
the addt·esses better, 
drag this cornet: 

\ 
i 
t 

0~~ 
- Co G .. ~--.. ..,. ........ ..... -

Tip: Each time you click on a link 
to go to that web site, the new 
web site replaces the previous 
one. If you want to open multiple 
browser windows so you can view 
several web pages, select the result 
in the middle panel, then go to 
the File menu and choose "Open 
in New Browser Window," or press 
Command B. You can have as 
many browser windows open 
as you want. 
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Shop on the Internet 
Sherlock doesn't just .find items for sale on the Internet-it actually provides you 
with their prices and availability. Amazing. 

Keep in mind that what Sherlock finds is dependent on what is offered for sale 
through the selected search sites; in the case of the Shopping channel, you can 
see below that Sherlock is only looking through selected sources. That is, if you 
want to compare prices of a down jacket from Lands End, L.L. Bean, and Orvis, 
Sherlock is not the right tool to use. But considering there are literally millions 
of items for sale in the search sites listed in Sherlock, it's not a bad place to look 
for many things. 

Search using the Shopping channel just as explained on the previous pages: 

1. Click the Shopping channel button. 

2. Type in your request (use quotation marks for phrases). 

3. Click the Search button; wait for the results. 

4. Double-click the result of your choice to go to that web site, OR: 

s. Single-click your choice to see more details in the lower panel, 
then if you still want to go to that site, click the link in the lower panel. 

1 

2 

0 (I 1-800 nowers.com 

~ [i} Amazon.com Auction built-in 

121 ~ Amazon.com Books built-In 

121 li!J Amazon.com Music built-in 

~ (iJ Amazon.com Vidl!o built-In 

0 0 Barn•• and Noble built- In 

~ G CNET Shopper built-In 

~ {16 eBay built- In 

0 "!" EyeWire built-In 

EJ iii GEMM built-In 

0 ~ REI buill- In 
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Sherlock 

E:J l "scrying mirror" 

Name .. Price Availability Site 
BEAUTIFUL RED STREAKED SCRYING MIRROR 

{Q ELEGANT!! Pivot Scrying Mirror by Amystical 

~~~~~~~~~~~~~ystlcal 

(Q SCRYING MIRROR IN STAIN GLASS 

f/6 SCRYING MIRROR IN STAINED GLASS/ROUND 

fi Scrylng Mirror 

~ UNUSUAL SCRYING MIR .. . ANGEL/CHERUB FRAME 

us $25.00 

us S45.00 

us 545.00 

US H5.00 

US 515.00 

US Hl.OO 
US Sl9.99 

us $19.98 

US S19.99 

5710402 MAGICKALI! Scrying Mirror Set! S S4S.OO 0 03(24 19:48 

Cotogo<y. EvoMh!ne Elst'Mo!.ftpbyn;nl 
Cwnmtly $4.!'.00 
QUAntity 1 
'!\me left 5 clsys, 9 hours + 

Stmted Mlll'IHJ~ 19.48:38 PST 
Ends M!ll'·~Hl~ 19:48 38 PST 

03/2 .. . :06 cgl.ebay.com 

03/2 .. . :13 cgl.ebay.com 

03/2.. .:06 cgi.ebay.com 

03/2 ... :48 cgl.ebay.com 

03/2 ... :14 cgl.ebay.com 

03/ 2 ... :43 cgl.ebay.com 

03/2 ... :35 cgl.ebay.com 

03/1...: 17 cgl.ebay.com 

03/2.. .:55 cgl.ebay.com 

Item 15710402 

Filst bid $45.00 
fofbids 0~ 
l.ooation T eJmS 

Co~mUy USA 
0 rrru1 tlus atp txm to ll fnand 
M. yntph tlus ltl!m 

..... .. 

Depending on which 
web site you go to, 
you can choose to 

buy (or in the case 
of eBay, bid on) the 

selected item. 
~ Seller (Rotmg) ;uuylljcaii!OOO UJ:ll '()] nc 
~ vmwconunenta mselktt fecdbockPmfiC I WWJellcrs pthcrpuptions I DSk Jelleraqw m n 

Htghbtd 
Payment \hsa.iMMte!~d. McneyOdeuCash~eTJ Chec4_ Ptuson.rJ Check& See 1torn descnpuon foi 

payment methods «:-oepted 
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Boolean operators 
The intimidating term "Boolean operators" (good name for a rock band) simply 
refers to using words like AND, NOT, and OR in your search. For instance, in 
the example below, I was able to find only research information that had the words 

"Mary Sidney" plus the word "Countess" on the page. If I did a search for just "Mary 
Sidney," I would have gotten a huge number of genealogy sites in the results. 

Most of the search engines on the web use Boolean operators. For more informa­
tion, go to just about any search engine site and click the "Help" button or the 

"Advanced Search" button, and look for information about Boolean operators. 

I clicked the "Reference" channel to search 
for encyclopedia and reference arNcles. 

-
" ( "Mary Sidney• AND countess ) 

Seard! Sites 

Ill Brltannlca.com built-In 

8 ~ Dict lonary.com built - In 

@ [)J Encyclopedia.com built-In 

8 "''" ili How Stuff Works built-In 

B fQ Roget's Thesaurus built- In 

-



;.:_;' 

: .·-· .. ·< .. '. ~·-~·:::~_;:;: ~-L-:;;' 

This chapter describes those places on the back or side of your computer where you 
plug things in (ports) and the things you plug into them (peripherals). You 
can spend years on your iMac without knowing the information in this chapter 
because one of the greatest things about the iMac is that if a cable fits into a port, 
it's the right match. It's not possible to plug something into the wrong place. So 
you don't really have to know anything about the back of your computer-if it 
fits, plug it in and move on. But when you get to the point where you want to know 
the difference between a FireWire port and a USB port and an Ethernet port, then 
dive into this short chapter. 
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Tip: To find out 
the latest information 
about iMac peripherals 

and adapters and 
everything related, 

go to 
www.madntouch.com/ 

imacusb.html. 
Also check the Apple 

site at www.apple.com. 

What is a peripheral? 
A peripheral is any item (or "device") that is outside of the main computer 
enclosure, but attached to it. Your mouse, keyboard, and printer are actually 
peripheral devices. Scanners and external hard disks are peripherals. If you have 
the Apple Pro Speakers, they are peripheral devices. 

What is a port? 
A port is a socket, a kind of receptacle, on the back of a computer (or on the 
backs of peripheral devices). The port is where you connect the peripheral device. 
A port is very different from a regular socket like electrical sockets in the wall, in 
that information goes both ways through a port. A wall socket sends power in only 
one direction- to a device. A port sends information back and forth between the 
computer and the device. 

There are lots of different kinds of ports, and peripherals are made to match a 
certain port type. For instance, you might have USB ports, to which you can only 
connect USB devices, such as USB printers. 

The cables that connect peripherals to your iMac (or to another peripheral) have 
connectors on the ends. The connectors match the ports. On an iMac, if the connector 
matches the port, it works. You can't plug a connector into the wrong port. 

Below are pictures of all these ports so you'll know exactly what you have. 

Secutity lock Apple Pro Ethernet Modem 
Speakers 

External monitor 

Power 
Empbones FiteWi,.e connection USB 

424 

Power 
button 
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What is USB? 
You'll probably hear the term "USB" often, as well as "peripheral." The acronym 
USB stands for Universal Serial Bus (which you don't have to remember). A "bus" 
is the system of wires, ports, and programming that a computer uses to connect 
peripherals and communicate with them. Until the iMac, Apple used a different 
sort of bus on Macintoshes, and so this switch to the USB is a big deal; it's the new 
technology that many (especially older) peripherals can't connect to. 

On the iMacs with the flat screen, all the ports are on the back side, as illustrated 
on the opposite page. You'll plug all of your peripherals into this place. The USB 

ports are the rectangular ones in the middle. Notice you have three of them, and 
your keyboard is already plugged into one. Your printer, one that either has a USB 

connector or uses an adapter, will plug into the other port. 

What is a connector? 
Connectors are the parts on the ends of the cables that actually make the con­
nection to the other device. The connector is the part that tells you what kind of 
cable it is-an Ethernet cable has a very different connector from a Fire Wire cable, 
which is very different from a USB cable (as illustrated on the following pages). 

Every connector is either male or female; take one look and you can guess 
why. The male or female shape is a very important identifying feature. When you 
start connecting lots of things together (like to project a presentation from the 
computer to a large wall screen), you will find yourself looking for either a male 
or female connector. 

Another identifying feature of connectors are the pins, or slender metal prongs 
on the male versions (not all connectors have pins). The number of pins is par­
ticularly useful in describing what you need. For instance, I once needed a cable 
for a video card that I installed in my computer. I didn't know exactly what kind of 
cable I needed, so I counted the little pin holes and told the guy I needed a 15-pin 
connector and he thought I knew what I was talking about. 

The shape is important. Some connectors are long and skinny, short and fat, 
rectangular or round, etc. Many connectors have identifying symbols that match 
the symbol on the port. On the next few pages are illustrations of the most common 
symbols that identify both the connectors and the ports. 
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77Jis is what an RJ45 
Ethernet port looks 

like, and the symbol 
that identifies it. 

This is the pm·t for 
an internal modem, 
and the symbol that 

identifies it. Don 't 
get the modem port 

confused with tbe 
lm'ger Etbernet port. 

This is what an 
AAUI port looks like, 

and tbe symbol 
tbat identifies it. 
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Ethernet ports 
Ethernet (pronounced eether-net) is the most common networking system for 
local area networks (IANs), which means the computers that are connected together 
are close enough to be connected with cables (as opposed to a wide area network, 
a WAN). iMacs have Ethernet ports which look like large phone jacks. You can use 
Ethernet in your home or small office to connect several computers so you can 
send files back and forth. 

Your printer might have an Ethernet port, in which case you can send data to the 
printer much faster than through the USB port. Even if it doesn't have an actual 
Ethernet port, you can get adapters for some printers so you can add the printer to 
your Ethernet network. In my office we use EtherMac iPrint Adapters from Farallon 
to network our good ol' workhorses-eight-year-old Apple LaserWriters. 

You also have a modem port for your internal modem, which looks exactly like 
an RJll phone jack (because it is), so don't get it confused with the Ethernet port. 
The Ethernet port is larger than the internal modem port. 

AAUiports 

Your iMac doesn't have an AAUI port, but you may want to connect to another 
computer that does have one. The MUI port (which stands for Apple Adapter Unit 
Interface) takes a variety of adapters for different networking systems, but the 
symbol for its port is the same as the symbol for an Ethernet port because Ethernet 
has become the most commonly used local area network. You can buy an Ethernet 
adapter for this port, called a transceiver, so you can connect your old computer 
to your new iMac that has an actual Ethernet port. 
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USB ports 
There are three USB ports on the back of your iMac, plus two others on the 
keyboard (the upper-left and upper-right comers of the keyboard). USB stands for 
Universal Serial Bus, which replaces both the Apple Desktop Bus and the serial 
ports (older types of ports). With USB, input devices (like mice and keyboards) as 
well as scanners, printers, Zip drives, and other devices can all connect into the 
same ports. 

You can't "daisy chain" USB devices, like you can Fire Wire devices 
(below), but you can buy a hub. The hub connects into one of the 
USB ports on the iMac, and several devices can plug into the hub. 
You can connect another hub to the first one, and so on, so you 
can supposedly connect up to 127 USB devices to one Macintosh. 
I don't know why you would, but you could. 

This d,-awing shows 
two USB po,-ts and 
the symbol that 
identifies USB. 

One of the greatest things about USB devices is that you can 
hot swap them; that is, you can connect and disconnect devices 
such as keyboards, mice, Zip drives, printers, or scanners without 
having to shut down the computer like you do with SCSI, serial, and 
ADB devices. Just don't swap devices while they're doing something, 
like copying to a Zip or scanning a photo or printing. 

This is a USB hub. Tbe back connecto1" 
goes into the computer's port, and the 
front conneclot· leads to a USB device. 

FireWire ports 
FireWire is Apple 's trademarked version of the standard called IEEE 1394. It's a 
high-performance "serial bus" for connecting up to 63 devices through one port 
on your iMac. 

The big deal about Fire Wire is this: It's extremely fast; you can connect 63 devices 
in any which way you like, such as in a star or tree pattern, and up to 16 in a single 
chain; you can hot swap them in and out without having to tum off the computer; 
they connect with a simple snap-in cable. 

You can connect a vast array of consumer electronics to FireWire, such as digital 
cameras, video tapes, and camcorders, as well as DVD (digital video disk), plus 
hard disks, optical disks, and printers. 

You might hear the FireWire ports called IEEE, but IEEE actually stands for the 
professional society, Institute of Electrical and Electronics Engineers, and IEEE 1394 
is a standard they developed. For instance, the Ethernet standard is IEEE 802.3. 

--Tbis symbol identifies 
a FireWit·e port. 

Tbese at"e the two ends 
of a FireWire cable. 
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This is the back side 
of an Epson printet: 
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Serial ports and parallel ports 
You iMac doesn't have a serial port or a parallel port, but your printer might, 
in addition to a USB port. 

The serial port is the little round one with lots of holes. There are two data wires 
in a serial cable, so the port can send and receive information at the same time. 

A parallel port is a big, horsey-looking port that looks like it came from a PC, 
which it did. Parallel ports transfer data through eight wires, so all eight bits in a 
byte can go through the line at once (in parallel). Sounds like it should be fast, but 
most parallel ports are not capable of sending and receiving data at the same time, 
which slows them down. Some PCs use the parallel port to connect to printers. 

Until recently, almost all printers for the Mac were "serial printers," which means 
they connected to a serial port on your computer. But, newer Macs (such as your 
iMac) don't have serial ports; they've been replaced with USB. 

Serial port USB port Pm·allet port 



.... Your computer gives you an attitude: .. 

Ms. Robin Williams 
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.rtf, .rtfd, 103 
.wbn, 110 
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initial setup, 14 
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Adobe Acrobat, 417 
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move an alias, 397 
put an alias in the Favorites folder, 395 
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some aliases are automatically created, 395 

AltaVista, 262 
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AOL. See America Online 
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create a slide presentation, 179-188 
create a spreadsheet, 145-158 



create a word processing document 
(type and fonnat a page), 113-123 
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Help files, 159 
integrating the modules, 81 
Starting Points palette explained, 112 
templates in AppleWorks, 81 
view the page larger, 113 
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what are they? 75 
add icon to the Dock, 43 
have certain ones open automatically 

when you tum on your iMac, 224 
how to quit, 130 
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Appl;cattons ;con ;n the Toolbar, 53 
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ARPA, 227 
ASCD file, 101 
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Atlas. See World Book encyclopedia 
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what are they? 342 
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backup 
backup your iMovie tiles, 391 
backup your iPhoto library, 390 
backup your iThnes library, 391 
how to backup, 205-212, 390 

if you have a SuperDrive, 390 
off-site storage, 390 

Bredderman-Barlow, Mary, 344 
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Baykal, Jay, 377 
Baysan, Oya, 377 
beta software, 221 
be:der tool, 175 
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Bloomberg rad;o, 381 
Booda the Auss;e, 282 
Boolean operators, 422 
booting up, what is it? 24 
Briard, example of, 259 
broadband connection, 247 

what is it? 6, 247 
TCP/IP pane for broadband, 247-248 
usefulness of a broadband connection, 247 
you don't ever have to log off the Internet, 264 

Combo Drive 

Browser NetHound, 234 
browsers 

why you need one, 234 
change the defaults to your liking, 256-257 
change the toolbar, 257 
Home button; set it to your preference, 257 
how to open it (Internet Explorer), 250 
set a default for your browser's email, 263 

bum a CD or DVD, 209-212 
bus, what is it? 425 

c 
cable connection to Internet, 6, 247 
cable modem, 238 
Calculator, 82 

Distance Calculator in the World Book, 109 
PCalc provides a printable tape, 95 

card readers, 272 
CDDB, what is it? 308 
CDs 

burn a CD (copy files onto it), 210-211 
CDR label on a CD changes after burning, 210-211 
different kinds of cos 

CD-ROM, CD-R, CD-RW, 209, 390 
inserting and removing, 68 
play a music CD, 69 
prepare disc for burning, depending on data, 210 
which ones can you record onto, 209 
which ones can you rewrite, 209 

channels ;n Sherlock, 412-422 
Chess,83 
chocolate pecan p;e, 418 
Class;c environment, 40~9 

example of startup screen, 24 
Clear and Delete, 123 
cUck-and-drag 

what does it mean, 26 
as opposed to press-and-drag, 35 

cl;pboard, 122 
Clock in the Dock, 83 
Close button (red), 28 
Close your documents, 129 
Columnv;ew 

blue scroller along the bottom, 41 
button icon in the window Toolbar, 52 
how to use Column View, 41, 65 
show more columns, 41 
triangles pointing toward the right, 41 
widen the columns, 41 

ComboDrive, 206 
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Command-click 

Command-click, 64 
Command key, 66 
CompadRash, 272 
Computer icon in Toolbar 

what the window displays, 53 
connecting several computers, 426. See also Ethernet. 
connecting to the Internet 

broadband connection, 6, 247 
dial-up connection, 6 

how to set up the modem connection, 240--246 
how to log on, 250--251 
networkconnection,6 
server, importance of, 6 
through America Online, 9-11 

connedors on the ends of cables 
what are they? 425 
male or female? 425 
pins, 425 

contextual menus (Control-click) 
on aDVD, 212 
to get Dock preferences, 45 

contiguous, what does it mean? 65 
Control key, 66 
convert 

music files from one format to another, 305 
photos to other file formats, 300 
temperatures, 95 

copy 
copy a file from one place to another, 61 
files onto a CD, 206-207, 209-211 
files onto a DVD, 2o6-207, 212 
files to your hard disk, 207-208 
text, 122 

credit cards, using them on the Internet, 11 
crystal ball icon (iDisk), 322-323 
cursor, what is it? 26, 114 
customize the appearance of Finder windows, 400 
customize the Toolbar pane, 399. 

See also Toolbar in Finder windows. 
cut (remove) text, 122 

D 
daisy chain, 427 
DAP, Directory Access Protocol, 360 
data, what does it mean, 78 
database 

what is it, what can you do with it? 78, 133 
create and format a database, 135-144 
example of a simple database, 133 
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Davis, Nancy, vi 
Delete and Clear, 123 
demo software, 221 
Desktop preferences 

change the background image, 215 
with iPhoto, 299 

Developer Tools, 93 
DHCP,248 
dial-up Internet account 

how to log on and off the Internet, 250--251 
set up the modem connection, 240--246 

digital, what is it? 236 
Digital Subscriber Line, 238. See alro DSL. 
digital video, 361 
disks/discs. See alro hard disk, cos, DVDs. 

why they're spelled differently, 205 
display 

if the text looks a little blurry on the screen, 216 
power light on the display, 72 
prolong the life of your flat-panel display, 71 

division symbol, 66 
Dock,42-45 

illustration of the Dock on the Desktop, 24 
what is each item in the Dock, 42 
add items to the Dock, 43 
change the minimizing effect (Genie vs. Scale), 44 
fax icons that appear in the Dock while faxing, 199 
folders in the Dock, how they act, 43 
hide or show the Dock, 44 
how to open files from the Dock, 42 
missing or wrong icons, 45 
move the Dock to the side of your screen, 44 
preferences for the Dock, 44 
quit an application from the Dock, 45, 130 
rearrange or move items in the Dock, 44 
resize the Dock, 44 
stop the icons from bouncing, 44 
System Preferences icon in, 46 
triangle in the Dock, under an icon, 42 
view "Help tags," 42 
which items automatically connect to the Internet, 42 

documents 
close them, 129 
double-click to open a document, 51 
find the document you created, 131 
icons match the application, 51 
save them, 124 
upper-right comer is turned down, 51 

Documents folder 
find the document you created, 131 
saving files into it, 124 



Doll Tearsheet, 115, 120 
double-click 

adjust the speed you need to click, 47-48 
how to do it, 26 

drag, what does it mean, 26 
drag-and-drop to open files, 395 
drawing, how to create one, 171-176 
drilling down through a directory, 261 
DSL connection 

what is it? 6, 238 
in apartment or office buildings, 248 
what does DSL stand for? 6, 16 

Dugger, Billy, 344 
duplicate a folder or file, 59 
DVDs 

burning files onto DVDs, 212 
how to play movie DVDs, 84-87 
inserting and removing, 68 

DVD Player application, 84-87 
Dynamic Host Configuration Protocol, 248 

E 
earl, 235 
earphones port, 70, 424 
Earth Link 

what is it? what does it cost? 10 
get broadband from EarthLink, 15 
national ISP, 7, 10 

Electric Library search tool, 262 
email 

what is it? 228 
addresses, what they look like, 228 
ALL CAPS is considered shouting, 230 
check your Mac.com account anywhere in the world, 321 
examples of, 229 
fields in a message, what to type in them, 229 
send photos from iPhoto, 295 
send Uri an email, 263 
set a default for your browser's email, 263 

encode,309 
encryption, what is it? 11 
Energy Saver to sleep your iMac, 71 
Engst, Adam, 267 
enter, what does it mean, 79 
entry page, what is it? 233 
Epson printer 

photo of the ports on the back side, 428 
Escape key, 66, 402 
ESPN,381 
EtherMac iPrint Adapters, 426 

fields 

Ethernet 
what is it? 426-428 
adaptor (transceiver), 426 
broadband connections use Ethernet, 6, 247 
connecting several computers, 426 
Ethernet ports (RJ45) 

how to tell Ethernet ports from modem ports, 426 
identifying symbol, 426 
photos of, 4, 424, 426 

standard IEEE 802.3, 427 
extensions, 388 

what are they? 388 
why are extensions important? 388 
examples of document extensions, 389 
hiding or showing extensions, 388, 389 
illegal characters, 389 
in web addresses, 255 

external modems, 424 

y 
FAQ, what is it? 230 
Fanllon, 426 
Favorites icon in Toolbar 

what are Favorites? 53 
FAXstf X, 189-204, 353 

Fax Browser 
set it up, 193-194 
use it, 201-202 

fax icons that appear in the Dock, 199 
install the application, 190--204 

set it up, 193-194 
Modem Center 

preferences for, 204 
set it up to fax, 195-196 

prevent FAXstf from picking up the phone, 200 
print a fax, 203 
receive a fax, 200 
send a fax, 197-198 
set up your printer to fax, 191-192 
view a fax, 202 

Fax Browser 
part ofFAXstf, 190--204 
set it up, 193-194 
use it, 201-202 

female connector, 425. 
fields 

what are they? 229 
enter data into fields, 138 
select fields backwards and fotwards, 138 
Tab to choose the next field, 13 
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Finder 

Finder 
customize the appearance of Finder windows, 400 
Finder Preferences, 401 
relaunching, 403 

Finder windows. See windows. 
Find and Replace, 100 
find any file on your hard disk, 411 
firewall, 247 
Fire Wire 

and electronic devices, 427 
daisy chain, 427 
FireWire cable, where to order one, 361 
identifying symbol, 361 
port, photo of, 424 
the big deal about FireWire, 427 

first level of your computer, 417 
first rule on the Madntosh, 116 
Fkeys,66 
flame, flame war, what is it? 230 
floating Clock, 83 
folders 

what are they? 50 
act like manila folders, 50 
add icons to the Dock, 43 
are technically also files, 49 
changing View Options, 400 
copy a file into a folder (don't just move it), 61 
drag a folder into a window, 58 
duplicate a folder or file, 59 
make a new folder, 54 

with a keyboard shortcut, 67 
move folders from one place to another, 56 
move them around in a window, 57 
open folders to windows, 54 

active windows, 54 
put something inside a folder, 58 
rename folders, 55 
take something out of a folder, 60 

force quit, 402, 403 
formatting text, 116-120 

guidelines for creating professional-level text, 132 
remove the fonnatting, 119 

freeware, 221, 262 
frequently asked questions (FAQ), 230 
function in a spreadsheet, 155 
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0 
"Genie Effect" of minimized windows, 30 

switch to the "Scale Effect," 44 
"Get Mac OS X Software ••• ," 221 

General preferences, 216 
Glossbrenner, Alfred and Emily, 262 
Google 

find a newsgroup, 231 
search for infonnation, 258-262 

gray items in the menu, 32 
gray Toolbar in a window, 54 
green button in a window, 28 

H 
Happy Mac icon, 24 
hard disk 

icon that represents your hard disk, 28, 33 
window showing hard disk items, 28 

put it to sleep to save energy, 71 
hardware, 24 
headphones port, 70, 424 
Hein, Simeon, 283 
Help tags 

in Sherlock, 412 
in the Dock, 42 

Hester, Nolan, 136 
Hide/Show Toolbar button, 28 
hierarchical menus, 36-37 
highlight 

change its color, 216 
indicates text is selected, 116 

h-menus, 36-37 
Home 

what is it? 53 
don't rename any folders in Home, 53 
move a folder into Home, 56 
see what's inside, 57 

Home Page 
build a web site with iTools, 324-328 

home page in a web site, 233 
Home page in your browser, 257 
horsey-looking port, 428 
HotBot, 262 
hot swapping 

what is it? 427 
and FireWire, 427 

Howell, Emma Jean, 5 
hub for USB devices, 427 



J 
1-beam 

how to position it where you want it, 114-115 
iCarcls, send them to friends and family, 318-319 
icons 

what are they? 50 
application icons, what they are, 50 
arrows on icons indicate aliases, 394 
arrow (tiny) on an icon, 394 
creatingicons,407 
document icons, how they work, 51 
folders icons, what they do, 50 
moving icons, 407 

Icon View 
button in the window Toolbar, 52 
select more than one file or folder while in Icon View, 64 

iDisk, aU about it, 322-323 
buy more space, 328 

iDVD, what is it? 375 
IEEE,427 
IUegal characters in file names, 389 
iMacs 

how to turn it on, 5 
serial number of your iMac, 25 
what kind of disk drive does it have? 2o6 
quotes regarding 

doesn't look like a computer, 386 
Fords vs. Lamborghinis, 2 
iThnes, 266 
Muse, 74 
PCS vs. Macs, 2 
scientist, planet, 226 

Image Capture, 88-92 
settings for your camera before you import, 88 

IMAP, 238 
iMovie, 361-376 

backup your iMovie files, 391 
don't let iMovies gobble up your 

hard disk storage space, 391 
five basic steps to making an iMovie, 362 
preserve disk space by emptying the trash, 365 
viewing your QuickTime movie with 

an older version of QuickTime Player, 375 
incoming mall server, what is it? 21 
insertion point 

how to position it where you want it, 114-115 
importance of the insertion point, 113 

Integrated Services Digital Network, 239 

iPhoto 

Internet 
what is it? 227 
brief history, 227 
glossary of terms, 238-239 
is not the World Wide Web, 227 
mailing lists and how to join one, 232 
newsgroups and how to find one, 230--231 
search the Internet and the ~b. 258-262 

using Sherlock, 418-419 
servers, importance of, 6 
shop on the web, 420--421 

Internet connection 
how to log off, 264 
how to log on, 250--251 
set the Network preferences, 242-248 
set the preferences for your modem, 246 
tell your iMac to connect automatically, 245 
types of connections, 6, 16 

for traveling, 10 
Internet Connect utility 

add modem status to menu bar, 251 
log off of the Internet, 264 
log on to the Internet, 250--251 

Internet Radio, 314 
use QuickTime to listen to the radio, 379, 384 

Internet Service Provider. See ISP. 
IP address, 244, 248 
iPhoto 

1-Click Ordering, 291 
Add button, 276 
Albums, all about them, 276-277 
arrange photos into groups, 274, 279 
backup your iPhoto Ubrary, 390 
checkmark for marking and searching photos, 281 
comments, where to enter them, 275, 279 
convert photos to other formats, 300 
create a Book of your photos, 289-290 

order your Book, 291 
yellow triangle on a photo, 290 

create a Screen Saver on your iMac, 299 
create a Slide Show to send someone else, 303 
create a Slide Show to show on your iMac, 293-294 
create a web site with your photos, 297-298 

edit your site with HomePage, 324-328 
export a web site for posting elsewhere, 301 

crop a photo, 284 
customize the editing toolbar, 288 
delete photos from iPhoto, 276--277 
delete photos from your camera while importing, 271 
Desktop background, change it with iPhoto, 299 
duplicate photos before making changes, 283 
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iPods 

edit your photos, 282-288 
undo your edits, or revert, 282 

email your photos, 295 
America Online users won't see them, 295 

export photos 
as web pages for posting on another site, 301 
in other formats, 300 

file formats iPhoto can use, 304 
headlines and captions come from titles 

and comments, 279 
HomePage, 297-298 

example of a web site, 298 
remove a HomePage album from the web site, 297 

ideal photo format for web pages, 326 
import photos 

from a card reader, 272 
from a CD or from your hard disk, 273 
from a digital camera, 271 

information on each photo file, 275 
install it, if it isn't already, 268-269 
JPG, ]PEG, what is it? 304 
keywords, assign them and search for them, 280-281 
Last Import Roll, 273 
list of compatible cameras and card readers, 267 
main window, explanation of, 270 
make your photos stronger, 284 
open a photo in a separate window, 288 
order real prints of your digital photos, 296 
order your Book of photos, 291 
organize your photos into Albums, 276-277, 278 
Photo Library 

backup the iPhoto library, 390 
how to find the iPhoto Library, 390 
shows all of your photos, 276-277 

Play button, 294 
preferences and what they are, 275 
print your photos to your desktop printer, 292 
red-eye, reduce it, 285 
revert to original photo after editing, 282 
roll number, what that means, 270 
rotate a photo, 285 
search for photos, 280-281 
thumbnails to larger photos on web site, 298 
titles, where to enter them, 275, 279 
undo your editing, or revert, 282 
version used in this book, 268 
Views in iPhoto, 274 
warning of damage upon disconnecting, 271 
where the photos are stored on your hard disk, 304 
yellow triangle on a photo, 290 
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iPods, 305,312 
ISDN, 239 
ISP 

what is it? (Internet Service Provider), 7 
AOLisyouriSP,9, 11 

you can use both AOL and an ISP, 11 
choose local or national, 11 
EarthLink, 7, 15 

what it costs, 10 
how an ISP works, 7 
local vs. national providers, 7 
reasons for wanting a national ISP, 10 

iTools 
what is it? 315 
who can get an iTools account? 315 
email, Mac.com account, 320 

autoreply to messages, 321 
check mail anywhere in the world, 321 
fmward your mail, 321 
get one for yourself, 316-317 

HomePage 
build a web site with iTools, 324-328 

iCards, send them to friends and family, 318,318-319 
iDisk, all about it, 322-323 

buy more space, 328 
ISP, iTools is not an 1SP, 18 
log in to your account, 316 
password question and answer, 18 
share files with friends, 323 

iTunes, 305-314 

J 

what's so great about iThnes? 309 
backup your iThnes Library, 391 
dazzling live visual-effects show, 305-314 
iPod, transfer songs to, 312 
iThnes interface, at a glance, 313 
play songs without putting in the CD, 308 
Radio Thner, 314 
select a range of songs, 310 

JPG, JPEG, what is it? 304 

K 
keyboard 

choose layout in the set-up process, 13 
keys to change the volume, 70 
USB ports on the keyboard, 427 

keyboard shortcuts 
how to use them, 66-67 
to Trash files, 63 



L 
LAN, local area network, 16,426 
LDAP, Lightweight Diredory Access Protocol 360 . , 
LeVitus, Bob, 266 
lightning storms, 3 
links on a web page, 235, 255 
List View 

button in the window Toolbar, 52 
disclosure triangles in List View, 39 
expand (open) folders, 39,40 
organize the contents, 39 

in the opposite order, 39 
rearrange the columns, 39 
resize the columns, 39 
select more than one file or folder, 65 
viewing contents in List View, 40 

local area network, LAN, 16, 426 
local provider. See ISP. 
Location, how to make one, 243 
lock a file, 393, 406 
Login preferences, 224 
log in to the iMac 

assign applications to open automatically, 224 
assign photos to users, 223 

log on, log off to the Internet, 239 
what does it mean? 225 
different from logging in to your iMac, 225 
how to log off, 264 

M 
Mac.com account 

how to get one, 316-317 
autoreply to email, 321 
check your Mac.com account anywhere in the world, 321 
forward your email, 321 

Madntosh HD icon 
opens your hard disk window, 28, 33 

Macosg 
what is it? 24 
Classic environment and OS 9, 24-25, 408-409 

Mac OSX 
what is it? 25 
build number of your version, 25 
example of Mac OS X Desktop, 24-25 
for more information about it 

'!be Little Mac OS X Book, xix 
web addresses, xx 

how to pronounce it, 25, xix 
importance of Administrator, 14 

Modem Center 

Macs. See iMacs. 
Mac The Dog, 299 
Macworld, 361 
magnetic media, 205 
Mail, 329-350 

auto-responder, 335 
can't apply formatting to selected text in email, 338 
delete unwanted funk mail, 331 
delete mail without having to open it, 331 
discourage unwanted email, 341 
extra features with your Mac.com account, 320-321 
get a Mac.com email address, 316-317 
how to find the POP address, 349 
IMAP servers 

Apple's IMAP server, 345-347 
copy Personal Mailbox to computer, 347 
full mailbox, 347 

manually mark an email you've already read 
as "unread," 343 

setup when you first turned on the iMac, 20 
SMTP (host, password, user ID), 350 
spam, 341 
vCard, 359 

male connedor, 425 
Map Search in the World Book, 109 
Media Ejed key, 68 
Memory Stick, 272 
menu bar and menus, 32-37 

add modem status to menu bar, 251 
example of menu bar and a menu, 32 
gray menu items, 32 
hierarchical menus (h-menus), 36-37 
how to use them, 32-37 
practice: 

change window view, 34 
select an item from a menu, 33-34 

put the modem status icon in the menu bar, 246 
put the Sound menu in the menu bar, 219 
triangle at the bottom of a long menu, 37 

Microsoft 
windows are different from Windows, 28 

mini-glossary of Internet terms, 238 
Minimize button (yellow) 

what it does, 30 
where it is, 28 
reopen a minimized window, 30 

Modem Center 
part of FAXstf, 190 
preferences for, 204 
set it up to fax, 195-196 
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modems 

modems 
what is a modem? 236 
broadbandconnection,6,247 
cable modem, 238 
dial-up connection (telephone), 6 

set up a dial-up modem connection, 240, 242-248 
internal modem on your iMac 

identifying symbol, 426 
photograph of the modem port, 4, 424, 426 

protect the connection, 3 
put the modem status icon in the menu bar, 246 
set the preferences for your modem, 246 
turn the sound off, 246 

modifier keys, 66 
monitors (displays) 

external monitor port, 424 
if the text looks a little blurry, 216 
power light on the monitor, 72 
prolong the life of your flat-panel display, 71 

mouse 
adjust the tracking speed, 47-48 
how to use it, 26 

single-click, double-click, etc., 26 
make it move across the screen faster, 47-48 
preferences for, 46 

mouse pad 
what is it? 27 
if you run out of room on it, 27 

movies, how to play them, 84--87 
MP3 audio files 

what are they? 306 
where you can play these files, 210 

multiplication symbol, 66 
music 

royalty-free music for you on Apple's site, 323 
music cos, how to play them, 69 

mute the sound, 70 
use the Sound preferences, 219 

My Channel, in Sherlock, 412 

N 
navigation bar, 252-253 
Nelson, Lew, 361 
Netlnfo Manager, 404 
Netscape browser, 234 
network 

what is it? 239 
Ethernet, 426 
LAN, local area network, 16, 426 
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Network icon in the Computer window, 53 
Network preferences 

DNS, 244 
enter your settings to get connected 

via telephone modem, 242-248 
IP Address, 244 
PPP pane, 245 
TCPIIP pane, 244 

newsgroups,230-231 
find a newsgroup, 231 

non-contiguous, what does it mean, 65 
Norrena, Jimbo, vi, 344 
Northern Light search tool, 262 
numeric keypad, 66 

0 
Ofoto for digital photos, 267 
OmniGroup, 234 
Open menu command, 113 

explanation of Open dialog box and columns, 273 
operating system 

what is it? 25 
which one is your computer running? 25 

optical media, 205 
Option key, 66 
Ostheimer, Hope, 344 
Otto Matic, 94 

open the manual in Acrobat Reader, 77, 94 
outgoing mail server, what is it? 21, 350 

.P 
painting 

create a painting, 161-169 
paint tools, 161-164 

parallel ports, 428 
passwords 

hint for user account, 14 
importance of Administrator password, 14 
iTools password question and answer, 18 
password hint for login, 223 
require a password to deactivate 

your Screen Saver, 217-218 
skip the password for login, 223 
standard password guidelines, 405 
store in a Rolodex, 18 
user account password for ISP is different 

from email password, 21 
paste text, 122 
PCalc, 95 



PDFs 
what are they? n 
create them in Preview, 103 
open in Acrobat Reader, n 
save any file as a PDF, 103 

periods, type one space after them, 114 
peripherals, 423-428 

what are they? 424 
connecting and disconnecting, 425 
where to plug in peripherals, 424 

photos 
ideal fonnat for web pages, 326 
if you don't have a digital camera, 267 
import and do stuff with Image Capture, 88 
import and do stuff with iPhoto. See iPhoto. 
order real prints of your digital photos, 296 
red-eye, reduce it in iPhoto, 285 
email photos 

as attachments using Mail, 336 
using iPhoto, 295 

use your photo as a Desktop background, 215 
view them quickly in Preview, 96 

pins, 425. See also connectors on the ends of cables. 
play a music CD, 69 
pointer 

cursor, also knovm as, 26 
follows the mouse movement, 26 
plus sign in the pointer, 61 
tip of the pointer is the important part, 26, 29 

ports, 423-428 
MUI ports, 426 
Apple Pro Speakers port, 70 
Ethernetports,426 

connect your old computer to your new iMac, 426 
headphones, 70 
identifying symbols, 426 
parallel ports, 428 
photos of iMac ports, 4, 424, 428 
serial ports, 428 
speakers, 70 
USB ports, 425 

photo of, 428 
what are they? 5, 424 

Power button 
where is it? 5, 424 
not the best way to shut down, 71, 72 

power cord, where to plug it in, 4, 424 
PPPoE,248 
PPP pane fn Network preferences, 245 
prebuffering streams, 314 
presentation, create one in AppleWorks, 179-188 

Recent Items 

press-and-drag 
what does it mean, 26 
as opposed to click-and-drag, 35 
move a window with press-and-drag, 29 

Preview, 96 
Print Center 

add your printer to the Printing List, 126-128 
set it up for faxing, 191-192 

Printer List, 126-128 
printers 

Epson, ports on the back, 428 
printing 

add your printer to the Printing List, 126-128 
fax with FAXstf, 191-192 
print your database, 144 
print your documents, 125 
print your photos from iPhoto, 292 

privileges, 404. See also root user. 
programming, what is it? 75 
protocol, what is it? 230, 346 
providers. See ISP. 
Proxies, 247 
pulse vs. tone phones, 246 

Q 
QTVR, Quicklime Virtual Reality, 3n 
Quicken Deluxe, 96 
Quicklime 

create a slide show in iPhoto, 303 
QuickTlffie movies, 377 

identifying icon, 382 
play a movie, 303 

Quicklime Player, 3n-384 
what's what, at a glance, 378 
1V and radio channels, 379 
why are some QuickTime icons bigger than others? 382 

quit an application, 130 
force quit an application, 402-403 

quotation marks, how to type real ones, 103 

radio 
play the radio on your iMac through 11\mes, 314 
use QuickTime to listen to the radio, 377, 379, 384 

Reader (Acrobat), n 
read-only files, 406 
re-authenticate to make changes, 405 
Reber, Kate, vi 
Recent Items, customize the number of, 216 
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records in a database 

records in a database, 139 
red button in a window, 28 
relaunch the Finder, 403 
remote server, 346 
rename a file or folder, 55 
resize 

columns in List View; 39 
windows,29 

Rich Text Format, 103 
rip a song in iTunes, 309 
robots, 259 
root password, 405 
root user, 404, 405 

.rtf, .rtfd, 103 
ruler in a word processor, 113 
Rule Number One on the Madntosh, 116 
Russell, Phil and Leigh, 361 

J 
save your documents, 124 

"Scale Effectn of minimized windows, 30 
switch to the "Genie Effect," 44 
sdentific calculator, 95 
Screen Saver, 217-218 

make a Screen Saver with iPhoto, 299 
turn it off, 217 

scroll bars and scrollers, 30-31 
make adjusbnents to their behavior, 216 

Search.Com, 262 
search for information 

on the web, 258-262 
limit your search with quotation marks, 259 
list of search tools, 262 
using a directory, 261 
using Google, 259 

search for files on your h~ disk, 413--415 
securitylock,424 
selecting text, 116 

select entire paragraphs for formatting, 117 
select more than one file or folder 

in Column View, 65 
in Icon View, 64 
in List View, 65 

serial number of your iMac, 25, 410 
serial ports, 427, 428 

serial printers, 428 
server, what is it? 239, 345 
Services, 98 
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setting up your iMac 
choosing EarthLink as your ISP, 7, 10, 15 
connect a phone cord for registering, 4 
keybo~layoutoption, 13 
Mail accounts, 20-21 
registration information, 13 
set-up process, 12-22 

connection options, 16 
Mail setup, 20-21 
network options, 17 
registering with Apple, 19 
telephone modem options, 17 
time zone, choosing one, 22 
wireless options, 17 

Shakespeare, William, 115, 120 
shareware, 221, 262 
Sherlock, 411--422 

what is Sherlock? 411 
what's what, at a glance, 412 

Advanced Search button, 422 
channels, 412,418-419 

what are they? 412 
channel icons, illustrations of, 418 
customize those empty slots, 412 

Contents button, 417 
searchable text formats, 417 
searching text files, 417 

indexing files, 417 
limit your search 

using Boolean operators, 422 
using quotation marks, 418 

removing a folder, 416 
resizing windows and panels, 419 
search 

a particular folder, 416 
if AOL is your only Internet service, 411 
the Internet, 418 
your h~ disk, 413 

Search button, 418 
shopping on the Internet, 420 

eBay, 421 
volumes, 416 

Sherlock Holmes hat, 411 
Shift-click, 64 
Shift key, 66-67 
short name, what is it? 223 
shouting online, 230 
Show Info window, 392 

create your own icons for your files and folders, 393, 407 
how to add comments, 392 
preview documents, images, and QuickTime movies, 393 



shut down, 72 
vs. leaving your iMac on, 72 

Shuttertly for digital photos, 267 
Sidney, Mary, 115, 120, 422 
single-click, how to do it, 26 
sleep and wake your iMac, 71 
slide presentation, create one in AppleWorks, 179-188 
SmartMedia, 272 
SMTP, what is it? 21 
software 

what is it? 24 
automatically update your Apple software, 220 
beta, demo, freeware, shareware, 221 
free software on Apple's site, 323 
get updates to non-Apple software, 221 
search sites for software, 262 

Software Update, how to use it, 220 
SOS: Save Often Sweetheart, 124 
Sound preferences, 219 
Spacebar, 66 
speakers 

choose the sound output, 219 
ports for speakers, 70 

Speech, 101 
speed of modem, 236 
Spelling menu option, 100 
Spencer, Edmund, 344 
spiders, 259 
spreadsheet 

what is it, what can you do with it? 79 145 
create and format a spreadsheet, 147-158 

squirrelly applications-what to do? 402 
Stickies, 97-98 
Streaming content, what is it? 381 
subtraction symbol, 66 
SuperDrive, 2o6, 390 
surf the web 

how to do it, 250-264 
what does it mean? 225 

surge protector, 3 
symbols on ports, 426-428 
System Preferences 

brief overview; 99 
where to find them, 214 
how to show them all again, 214 
Classic, 408-409 
Desktop, 215 
Dock, 44 
Energy Saver to sleep your iMac, 71 
General,216 
Internet, 317 

Toolbar in Finder windows 

Login, 224 
Mouse, 46 
Network preferences, 242-248 
Screen Saver, 217-218 
Software Update, 220 
Sound,219 
Users, 222-223 

~r1 

Tab key 
to select fields backwards and forwards, 138 

Taylor, Laura Egley, iv, vi 
TCP /IP pane in Network preferences, 244 
telephone modem 

dial-up connection to the Internet, 6 
set it up, 242-248 

template, what does it mean, 81 
text 

changing the typeface, size, color, etc., 116-120 
formatting text, 116-120 
if the text on your monitor looks a little blurry, 216 

Text Color dialog box, 119 
TextEdit, 100-103 

add photos to a page, 102 
text-only file, 101 
text smoothing, 216 
Thomas, Tim, 361 
Thornton, Elbabeth, 283 
title bar of a window 

in an active window, 54 
title bar changes its name, 400-401 
where is it? 28 

Tollett, John 
digital artist quote, 74 
introduction, xix 
mouse pad design, 27 

Toolbar in Finder windows, 398 
add a file or folder to the Toolbar, 48 
add Bum icon (cos or DVDs) to the Toolbar, 211 
Back button, 52 
colored buttons, 28 
customize the Toolbar pane icons, 399 
double-arrow at the right end of the Toolbar, 48, 398 
gray Toolbar, 54 
Hide/Show Toolbar button, 28, 52 
how to customize the Finder window Toolbar, 398 
icons in the Toolbar, 52 

Applications, 52-53 
Computer, 52-53 
Favorites, 52-53 
Home, 52-53 

441 



transceiver 

rearrange items in the Toolbar, 398 
remove items from the Toolbar, 48 
too many icons? 398 
View buttons, 38, 52 
when the Toolbar is hidden, separate windows open, 52 

transceiver, 426. See also Ethernet. 
Trash basket, how to use it, 62-63 
traveling, Internet connection for, 10 
tum on your iMac, 5 

for the first time (set-up process), 12-22 
typing. See word processing. 
typos, how to fix them, 114-115 

u 
ugly monster, 168 
Ultimate Answer, 95 
Undo, 122 
Uniform Resource Locator, 235 
Universal Serial Bus. See USB. 
untitled folder, how to name it, 55 
URL 

what is it? 235 
how to enter a URL to find a web site, 252-253 

Url Ratz, 235 
Url's Internet Cafe, 27, 252 
USB 

what is USB? 425 
interchangeable input devices, 427 
on the keyboard, 427 
USB ports, 424, 427 

photo of USB hub, 427 
user account ID for your ISP, 21 
users 

why to have other users, 14, 222 
assign photos to users for login, 223 
Home for each user, 53 
how to create another user, 222 
open files and applications automatically on login, 224 
password hint, 14 
setting up your own user account, 14 
skip the password so young users can log in, 223 

v 
vCard,359 
View buttons, 38-41 
View menu, 34 
View Options, 400 

customize the appearance of Finder windows, 400 
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~ewsoflrindows,~1 
~llage of America Online, 8-9 
volume (sound) 

change it from the keyboard, 70 
change the main volume or the alert sounds, 219 

volumes (as in disks), 416 
VTR, ~deo tape recorder, 362 

w 
wake up your iMac, 71 
WAN, wide area network, 426 
.wbn, 110 
.wbt, 110 
web addresses 

caps or lowercase letters in an address, 253 
enter a corporate web address, 255 
find a newsgroup, 231 
Netscape browser, 234 
OmniWeb browser, 234 
URL (Uniform Resource Locator), 235 
where NOT to type a web address, 253 
where to type in a web address, 252 

web pages. See also web sites. 
what are they? 233 
build your own 

with Image Capture, 89 
with iPhoto, 297-298 

web sites 
add web site addresses to the Dock, 43 
Back button, 254 
find a corporate web site easily, 255 
Forward button, 254 
how to enter a web address, 252-253 
how to get around a web site, 254 
how to go to a web site, 252-253 
links on a web page, 235,255 
make the text larger on a web page, 256 
see a list of pages you've been to, 254 
send email from a web page, 263 
web addresses for: 

Apple, XX 

AppleWorks information, 81 
check your Mac.com email anywhere in the world, 321 
compatible camera, printers, digital card readers, 267 
EarthLink, 15 
entertaining QuickT1me content, 379 
film processors who can post your photos 

on the web to download, 267 
Google search tool, 258 
iMovie info and downloads, 369 



iPhoto infonnation, 267 
join a mailing list, 232 
list of search tools, 262 
Louvre Museum, 382 
MacAddict, XX 

MacFixit, XX 

MacinTouch, xx 
MacMinute, xx 
Mac OS X hints, xx 
MacWarehouse, xx 
peripherals, 424 
Url's Internet Cafe, 252 
VersionTracker, xx 

wide area network, WAN, 426 
Wilde, Ethan, 82 
Williams, Reilly (my Briard), 259 
Williams, Ryan, 344, 407 
Williams, Scarlett, 102, 295, 377 
windows 

what are they? 28 
active windows, what are they? 54 
blue things in the window edges (scrollers), 30-31 
close a window with a keyboard shortcut, 67 
colored buttons in the corner, 28 
Column View, 41, 65 
explanation of the various parts of windows, 28 
Hide/Show Tool bar button, 28 
hide Toolbar to open new, separate windows, 52 
Icon View, 64 
List View, 38-39, 65 
make all windows open in the same view, 401 
make new Finder windows open to your Home level, 401 
move a window, 29 
number of items in a window, 31 
open a new window every time 

you double-click a folder, 401 
quiz on window features, 31 
resize a window, 29 
scrollbars and scrollers, 30-31 
Toolbar icons, what are they? 52-53 
views of, 38-41 
View buttons, 38 

word processing 
what is it, what can you do with it? 78 
all about it, 113-123 
close your document, 129 
create another document, 129 
delete everything on the page, 115 
guidelines for creating professional-level text, 132 
if you made a big mistake, 129 

Zoom button 

revert to a previously saved version, 129 
using TextEdit, 100-103 
window features explained, 113 

word wrap, 114 
World Book encyclopedia, 104-110 
World Wide Web. See also web sites. 

what is it? 233 
why you need a browser, 234 
home page, entry page, 233 
is not the Internet, 227 
links, what are they? 235, 255 
search the web 

using Sherlock, 418-419 
using web search tools, 258-262 

shop on the web with Sherlock, 420-421 
web address, what is it, 235 

X 
X, what is it? 25 

4y 
Yahoo,262 
yellow button in a window, 28 

z 
Zip disks, copying to and from, 206-208 
Zoom button, 28, 29 
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John Tollett and Robin Williams 
We live on several acres just south of Santa Fe, 
New Mexico, where we can see every sunrise and 
sunset, every moonrise and moonset. And we can 
see the ski trails on the mountain. Between us we 
have four kids and several dogs. John has lots of 
electronic equipment and Robin has lots of books. 

Other books by Robin 
The Little Mac OS X Book 
The Little Mac Book, seventh edition (for Mac OS 9) 
The Little iBook Book 

(and John Tollett) 
The Mac is not a typewriter 
The Non-Designer's Design Book 
The Non-Designer's Type Book 
The Non-Designer's Web Book 

(and John Tollett) 
The Non-Designer's Scan and Print Book 

(and Sandee Cohen) 
Robin Williams Design Workshop 

(and John Tollett) 
Robin Williams Web Design Workshop 

(and John Tollett and Dave Rohr) 
Windows for Mac Users 

(and Cynthia Baron) 
A Blip in the continuum 

(and John Tollett) 
How to Boss Your Fonts Around (for Mac OS 9) 

and several other books 

Colophon 
We created this book on several Macintoshes 
running Mac OS X, sharing files across the office. 
We used Adobe InDesign 2.0, which is fabulous, 
especially the book features. Wow. The fonts 
used are the Tree family from [T-26], Garamond 
Condensed from Adobe Systems, and ITC Officina 
Sans from ITC. 
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The Little iMac Book 
Third Edition John Tollett & Robin Williams 

The head-turning and powerful iMac just keeps getting better! 
The newest generation of iMacs includes everything you need to connect to the Internet, 
send and receive email, transfer your digital photos to the computer and send them to 
friends, and even create your own music COs. And now The Little iMac Book is completely 
revised to cover all of the iMac's new features. There's no better way to learn the iMac than 
from the Mac community's leading teacher, Robin Williams, and her long-time collaborator 

and co-author, John Tollett. If you are new to the iMac, open this book, sit down at your iMac, and let Robin and John show 
you how to get started with your new computer. 

You' ll learn: 

• A.ll about the mouse, menus, icons, views, and folders 
• How to use the Dock 
• How to copy, move, and delete files 

Once you master mousing and getting around the 
Desktop, you'll also learn: 

• How to start a new document, make changes, save, 
print, and quit 

• How to use a word processor, database, spreadsheet, 
paint, and draw programs 

• How to send and receive faxes 
• How to create your own digital movies with iMovie 
• How to play music COs- or create your own 
• How to burn DVDs if your iMac has a SuperDrive 

About the authors 

Robin Williams' love for teaching and 
her real-world teaching experience has 
earned her the praise of students and 
critics around the world. She has written 
numerous best-selling and award-winning 

books, including The Littl~ Mac OS X Book, The Non­
Designer's Design Book, and Robin Williams Web Design 
Workshop. Robin has helped hundreds of thousands of 
people to move forward with confidence. 

Book Level: 
Beginning Mac Users 

Shelf Category: 
Macintosh 

For Computers Using: 
Flat-panel iMacs 
and Mac OSX 

0 Peach pit Press 
1249 Eighth Street 
Berkeley, CA 94710 
800 283-9444 
510 524·2178 
510 524-2221 fax 
Find us on the World Wide Web 
at www.peachpit.com 

And then it's on to the Internet and the World Wide 
Web. You'll learn the basics of: 

• Getting connected to the Internet 
• Browsing the web 
• Searching the web using various tools 
• Receiving and sending email, including photos 
• Creating web pages of your photos and posting them 

on the Internet 
• Using your free iTools account from Apple to share 

files with family and friends 

This book is completely understandable, basic, and 
fun-as fun as the iMac itself. There's no better way 
to get up and running and productive on your iMac­
and have a good time doing it. 

John Tollett is a Mac consultant and 
t rainer who has co-authored several books 
with Robin, including The Non-Designer's 
Web Book, The Little iBook Book, and 
Robin Williams Design Workshop. John 

has been a professional user of the Macintosh since 
1988, specializing in print and web design. 

USA $21.99 Canada $34.99 UK £16.99 

ISBN 0-321-11630-5 
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